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11. Drainage Basin 

11.1. Objectives 
 
 

 Learn basics of water cycle 
 Learn basics of a drainage basin 
 Learn to delineate a drainage basin of a channel using AutoCAD 
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11.2. Introduction 
Hydrology is a Greek word, and it means the study of water. In the engineering 
community, hydrology is the scientific study of the movement, distribution, and quality 
of water throughout the earth. Hydrology addresses both the hydrologic cycle and water 
resources. 

11.3. Hydrologic cycle 
The hydrologic cycle, also known as the water cycle, is the continuous movement of the 
water above, on, and below the surface of earth. Hence, there is no beginning or ending 
of this cycle. In the various stages of this cycle, water is available in one of the three 
different possible states: liquid, vapor, and ice. The most simplified representation of the 
hydrologic cycle is as follows. The major driving force of the hydrologic cycle is the sun. 
It heats the water in the oceans, lakes, rivers, streams, etc. and causes some of it to 
evaporate. The vapor rises into the air where cooler temperatures cause it to condense 
into clouds. These clouds drift over the land and the vapors fall as precipitation (rain, 
hail, snow, fog, etc.). The rainwater flows into lakes, rivers, or aquifers. The water in 
lakes, rivers, and aquifers then either evaporates back to the atmosphere or eventually 
flows back to the ocean, completing the cycle. Figure 11-1 shows a water cycle. 

 

 

Figure 11-1 
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The hydrological cycle can be affected by the environmental effect and by humans. The 
following list shows some of the human factors affecting the water cycle. 
 Agriculture  
 Alteration of the chemical composition of the atmosphere  
 Construction of dams  
 Deforestation and afforestation  
 Removal of groundwater from wells  
 Water abstraction from rivers  
 Urbanization 

11.4. Terminology 
Refer to the Figure 11-1 for the terms discussed in this section.   
 
 Condensation: Condensation is the transformation of water vapor to liquid water (as 

seen with the droplets in the air that produce clouds and fog). 
 Precipitation: Precipitation is the process of condense water vapor falling to the 

earth's surface. Generally, precipitation occurs as rain. It also occurs as snow, sleet, 
hail, and fog drip. 

 Interception: Interception is the precipitation that is interrupted by building, plant 
foliage, etc. Part of the intercepted precipitation will reach the ground surface and 
the remaining part will evaporate back to the atmosphere.  

 Runoff: Runoff is the method by which water moves across the land. This includes 
both surface runoff and channel runoff. As water flows, it may infiltrate into the 
ground, evaporate into the air, become stored in lakes or reservoirs, or be extracted 
for agricultural or other human uses.  

 Snowmelt: Snowmelt is the runoff produced by the melting snow.  
 Groundwater: Groundwater is the water found below the ground surface. It may be 

available as soil moisture, liquid form, or frozen form. 
 Infiltration: Infiltration is the percolation of the water from the ground surface into 

the ground. Once infiltrated, the water becomes soil moisture or groundwater. 
 Subsurface flow: Subsurface flow is the underground flow of water. It may return to 

the surface as a spring or by the extraction using pumps. 
 Advection: Advection is the movement of water (in solid, liquid, or vapor states) 

through the atmosphere. Without advection, water that evaporated over the oceans 
could not precipitate over the land. 

 Evaporation: Evaporation is the transformation of water from a liquid to a gaseous 
state.  

 Transpiration: Transpiration is the evaporation of water from the plants.  
 Evapotranspiration: Evaporation and transpiration are collectively known as 

evapotranspiration. 
 Sublimation: Sublimation is the transformation of water from a solid (ice) to 

gaseous (vapor) state. 
 Water table: Water table is the underground water level at which the ground water 

pressure is equal to the atmospheric pressure. 
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11.5. Watershed or Drainage basin 
A watershed is the area of land that drains into a stream at a given location; that is, it is an 
area of land bounded by a hydrologic system. Generally, a watershed is defined in terms 
of a point or outlet and all the land area that sheds (pours) water to the outlet during a 
rainstorm. Using the concept that “water runs downhill,” a watershed is defined by all 
points enclosed within an area from which the rain falling at these points will contribute 
water to the outlet. Figure 11-2 represents the delineation of a watershed boundary. 
Watersheds come in all shapes and sizes and cross state and national boundaries. For 
example, the Mississippi river drainage basin covers more than 30 states and two 
Canadian provinces. 

 

 

Figure 11-2 

A drainage basin is a region of land where the precipitation’s water flows downhill into a 
river, lake, dam, or ocean. The drainage basin includes both the channels and the land 
from which water drains into those channels. Each drainage basin is separated 
topographically from adjacent basins by a ridge, hill, or mountain, which is known as a 
water divide. In Figure 11-2, the dashed line is the main water divide of the hydrographic 
basin. In North America, watershed refers to the drainage basin itself. The terms 
catchments, catchment area, catchment basin, drainage area, river basin, and water basin 
are also used to represent the same concept.  
 
The majority of water that discharges from the basin outlet originated as the precipitation 
falling on the basin. In hydrology, the drainage basin is a logical unit of focus for 
studying the movement of water within the hydrological cycle. A portion of the water 
that enters the groundwater system beneath the drainage basin may flow towards the 
outlet of another drainage basin because groundwater flow directions do not always 
match those of their overlying drainage network. Measurement of the discharge of water 
from a basin may be made by a stream gauge located at the basin's outlet. 

11.6. Watershed characteristics 

11.6.1. Drainage area  
The drainage area (A) is probably the single most important watershed characteristic for a 
hydrologic design. It reflects the volume of water that can be generated from rainfall. The 
drainage area is used to indicate the potential for rainfall to provide a volume of water. It 
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is common in hydrologic design to assume a constant depth of rainfall occurring 
uniformly over the watershed. Under this assumption, the volume of the water available 
for the runoff would be the product of rainfall depth and the drainage area. Thus the 
drainage area is required as input to models ranging from simple linear prediction 
equations to complex computer models.  

11.6.2. Watershed length 
The length (L) of a watershed is the second greatest characteristic of interest. While the 
length increases as the drainage increases, the length of a watershed is important in 
hydrologic computations. Watershed length is usually defined as the distance measured 
along the main channel from the watershed outlet to the basin divide. Since the channel 
does not extend to the basin divide, it is necessary to extend a line from the end of the 
channel to the basin divide following a path where the greatest volume of water would 
travel. The straight-line distance from the outlet point on the watershed divide is not 
usually used to compute L because the travel distance of floodwaters is conceptually the 
length of interest. Thus, the length is measured along the principal flow path. Since it will 
be used for hydrologic calculations, this length is more appropriately labeled the 
hydrologic length. The length is usually used in computing as a time parameter, which is 
a measure of the travel time of water through the watershed. 

11.6.3. Watershed slope 
Flood magnitudes reflect the momentum of the runoff. Slope is an important factor in the 
momentum. Both watershed and channel slope may be of interest. Watershed slope 
reflects the rate of change of elevation with respect to distance along the principal flow 
path. Typically, the principal flow path is delineated, and the watershed slope (S) is 
computed as the difference in elevation (E) between the end points of the principal flow 
path divided by the hydrologic length of the flow path (L).  
 
The elevation difference, E, may not necessarily be the maximum elevation difference 
within the watershed since the point of highest elevation may occur along a side 
boundary of the watershed rather than at the end of the principal flow path. 

11.6.4. Miscellaneous      
Some of the other important watershed factors are listed here. 
 Land cover and use 
 Surface roughness 
 Soil characteristics 

o Texture 
o Soil structure 
o Soil moisture 
o Hydrologic soil groups 
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11.7. Major steps in a watershed delineation 
The major steps in watershed delineation process are listed below.   
 
Step 1: Mark the centerline of the channel by joining the Vs. For a channel, the tip of the 
V is upstream.  
Step 2: Show the direction of flow. A channel flows from a higher elevation (upstream) 
to the lower elevation (downstream). 
Step 3: Delineate the watershed boundary by connecting the ridge lines in the elevation 
contour lines map. For a ridge, the tip of the V or U is downstream. 
Step 4: Choose and label the point of the watershed outlet. The outlet is usually a 
monitoring location or hydraulic structure.    

11.8. Watershed delineation using AutoCAD  
In AutoCAD the watershed delineation can be performed using the following steps. 
 

1. Launch AutoCAD 2013. 
2. Contour map 

 Open the contour map previously created or downloaded map. 
 Create the layers as shown in Figure 11-3. 
 Change the color, linetype, and lineweight of the layers. 

 

 

Figure 11-3 

3. Counter labels 
 Make the Contour_Labels layer to be the current layer. 
 Label the index contour using the Text, Background Mask, and the Rotate 

commands, Figure 11-4. The text height is 12 feet in the sample watershed. 
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Figure 11-4 

4. Center line 
 Make the Channel_CL to be the current layer. 
 A channel flows from the higher elevation to the lower elevation. As mention 

earlier, the contour lines cross the streambed upstream by creating V with the 
bottom of the V’s pointing upstream. 

 Draw the centerlines for the channel, Figure 11-5.  
o Activate the Polyline command. 
o Draw a polyline through the bottom of Vs as shown in Figure 11-5. 

 

 

Figure 11-5 
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5. Direction of the flow 
 Make the Channel_DF to be the current layer. 
 Show the direction of the flow for the channels using the quick leader. Use first 

part of the qleader command to draw arrows; arrowhead size is 18ft – 24ft. 
 Label the channel as shown in Figure 11-6. 

 

 

Figure 11-6 

6. Outlet point 
 Make the Outlet layer to be the current layer. 
 In Figure 11-7, Outlet, the intersection of the channel and the edge of the 

contour map is selected as the outlet point for the watershed. 
 Draw a point at the outlet and label it.  

 

 

Figure 11-7 
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7. Delineate the watershed 
 Make the Watershed_Boundary layer to be the current layer. 
 The contour lines cross the ridge downstream by creating V’s or U’s pointing 

downstream. 
 Draw the boundary lines for the channel.  

o Activate the Polyline command. 
o Draw a polyline through the bottom of Us as shown in Figure 11-8. 

 

 

Figure 11-8 

8. Hatch the watershed 
 Make the Watershed_Hatch layer to be the current layer. 

o Turnoff all the layers except the Watershed_Boundary and 
Watershed_Hatch layers, Figure 11-9a. 

 

 

Figure 11-9a 
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o Draw polylines to close the open ends of the water shed boundary. 
o Join the polylines (using polyline edit command) to form a single close 

polyline. 
o Activate the Hatch command. 
o Hatch the watershed, using the pattern GRASS and the scale of 70,        

Figure 11-9b and Figure 11-9c. 
 

 

Figure 11-9b 

 

Figure 11-9c 

9. Channel length 
 Make the Area-Length to be the current layer. 
 Set the drawing units to be engineering as follow. (i) From the Format menu, 

select the Units option. This will open Drawing Units dialog box. (ii) In the 
Drawing Units dialog box, under the Length panel, select the Engineering units, 
Figure 11-10a. 
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 Find the length of the channel in feet (length of the channel’s center line).  
 The length of the channel in feet can be obtained using one of the two 

techniques. 
(a) Using the Property sheet 

o The easiest and the fastest method is the property sheet. 
o Select the centerline of the channel and open its property sheet,      

Figure 11-10b 
o The last entry in the Geometry panel is the length of the channel. 

(b) Using the Inquiry command 
o The length of the channel can also be found by click the Tools menu 

followed by Inquiry command and the selecting Distance command, 
Figure 11-10c.  

o Follow the prompts. 
 

                        

             Figure 11-10a                           Figure 11-10b 

 

Figure 11-10c 

10. Watershed area 
 Make the Area-Length to be the current layer. 
 Find the area of the watershed in acres. 
 The area of the watershed can be obtained using one of the two techniques. 

 
(a) Using the Property sheet 

o Select the boundary of the watershed (the closed polyline). 
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o Open its property sheet, Figure 11-11a. 
o The second last entry in the Geometry panel is the area of the watershed. 
o The area is in square feet.  

 

 

Figure 11-11a 

(b) Using the Inquiry command 
o Select the Tools dropdown menu, select the Inquiry option, and select 

the Area option, Figure 11-11b. 
o The prompt shown in Figure 11-11c will appear. 

 

 

Figure 11-11b 

o Use the down arrow and choose the Object option for the closed 
polyline.  

 

 

Figure 11-11c 
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o Click on the watershed boundary (make sure the boundary is represented 
by a single closed polyline). 

o The area information will appear on the screen, Figure 11-11d. 
o Press the Esc key to exit the command. 

 

 

Figure 11-11d 

 Convert the area into acres using the conversion factor of                        
1 Acres = 43560 sq. ft. 

 
11. Display the length and area on the drawing 

 Create two texts boxes to show the length in feet and the area in acres on the 
drawing, Figure 11-12. 
 

 

Figure 11-12 
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12. Insert Template file 
 Finally, insert a layout from the template file labeled as 

“My_acad_Landscape_tmplt.dwt”. 
 Set the viewport scale to 1:960. 
 Lock the viewport 
 Update the Title block. 
 The resultant drawing in the layout is shown in Figure 11-13. 

 

 

Figure 11-13 

 
 




